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A When collapsed, 
each panel has  
a unique icon.

Identifying the panel icons
Each panel in Illustrator has a unique icon.A If you 
keep the panels collapsed to conserve screen space, 
you can identify them by their icons. If you don’t 
recognize a panel icon, use the tool tip to identify it.

Using the context menus
When you right-click in the document, depending 
on where you click and which tool happens to be 
selected, a menu of context-sensitive commands 
pops up onscreen. If a command is available on a 
context menu (or can be executed quickly via a key-
board shortcut), we let you know in our instructions, 
to spare you a trip to the main menu bar. 

Note to Mac OS users: If your mouse doesn’t have 
a right-click button, hold down Control and click to 
open the context menu.

hiding and showing panels and tools

Hide or show all the currently 
open panels, including the Tools 
panel and tearoff toolbars

Tab

Hide or show all the currently 
open panels but not the Tools 
panel or tearoff toolbars

Shift-Tab

This is the con-
text menu for a 
selected object. 
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Using the Tools panel 
In addition to the tools on the Tools panel, which are 
used for creating and editing objects, you will also find 
color controls, a menu or icons for choosing a draw-
ing mode, and a menu for choosing a screen mode. If 
the panel is hidden, choose Window > Tools to display 
it. To convert the panel layout from single column to 
double column or vice versa, either click the double 
arrowhead at the top or double-click the top bar.

Click once on a visible tool to select it, or click and 
hold on a tool that has a tiny arrowhead to choose 
a related tool from a fly-out menu. You can cycle 
through tools on the same menu by Option/Alt click-
ing the visible tool. 

To create a tearoff toolbar for a group of related 
tools,★press and hold on the arrowhead for a tool, 
then click the vertical tearoff bar on the right edge of 
the menu.A–B To dock tearoff toolbars together, drag 
one tearoff toolbar to the side of an existing one and 
release when the vertical drop zone line displays.C–D 
To make a tearoff toolbar vertical instead of horizontal, 
click the double-arrow E–F or double-click the top bar. 
To close a docked tearoff toolbar, drag it by its gripper 
bar out of its dock, then click its close button (x).

To access a tool quickly, use the letter shortcut that 
is assigned to it. The shortcuts are listed in parentheses 
on the next two pages, and also in the tool tips 
onscreen.G (Note: If the tool tips aren’t displaying, go 
to Illustrator/Edit > Preferences > General and check 
Show Tool Tips.)

Some tools can also be accessed temporarily via a 
toggle key. For example, pressing Cmd/Ctrl turns the 
current tool into a temporary selection tool. You’ll learn 
many tool toggles as you proceed through this book.

To turn the tool pointer into a crosshairs icon for 
more precise positioning, go to Illustrator/Edit >  
Preferences > General and check Use Precise Cursors. 
Or if you prefer to keep that preference off, you can 
turn the pointer to a crosshairs icon temporarily by 
pressing the Caps Lock key.

You can choose options for the current tool from 
the Control panel (see page 42). Some tools, such as 
the Paintbrush and Pencil tools, have a related options 
dialog, which opens when you double-click the tool or 
when you click the tool and then press Return/Enter.

D Now two tearoff toolbars 
are docked together.

G The tool 
shortcut 
displays in 
a tool tip.

B The floating tearoff 
toolbar was moved upward.

C A second tearoff toolbar 
is docked to an existing one.

A A tearoff toolbar 
is being created.

E The double arrow 
on a tearoff toolbar 
is clicked, to switch 
its orientation …

F … to vertical.
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The Tools panel illustrated

Lasso (Q) Selects individual points and seg-
ments on a path by dragging around them

Rectangle (M) Draws rectangles and squares

Pencil (N) Draws freehand paths

Scale (S) Enlarges and shrinks objects

Free Transform (E) Rotates, scales, reflects, 
shears, distorts, or applies perspective to objects

Perspective Grid (Shift-P) Puts objects into 
one-, two-, or three-point perspective

Gradient (G) Changes the position, length, 
radius, or angle of existing gradients

Blend (W) Creates shape and color blends 
between objects

Column Graph (J) Creates column graphs

Eraser (Shift-E) Erases sections of objects

Zoom (Z) Changes the zoom level of a 
document 

Swap Fill and Stroke (Shift-X) Swaps the 
current fill and stroke colors

Stroke (press X to toggle or click to activate) 
The color or pattern that’s applied to a path

Drawing modes: Draw Normal, Draw 
Behind, or Draw Inside (Shift-D)

None (/) Sets the current stroke or fill color 
to None

Screen modes (F) Change the size of the 
document window and control the display 
of Illustrator features

Magic Wand (Y) Selects objects based 
on their color and opacity attributes 

Direct Selection (A) Selects and reshapes 
objects by their anchor points and segments

Selection (V) Selects, moves, and 
transforms entire objects

Pen (P) Draws paths that are composed 
of curved and/or straight segments

Line Segment (\) Draws separate 
straight lines at any angle

Paintbrush (B) Creates Calligraphic, 
Scatter, Art, Bristle, or Pattern brush strokes

Blob Brush (Shift-B) Creates closed 
freehand shapes (or reshapes them)

Rotate (R) Rotates objects

Width (Shift-W) Reshapes  
an object’s stroke

Shape Builder (Shift-M)   
Combines objects

Mesh (U) Creates and edits 
multicolored mesh objects

Eyedropper (I) Samples and 
applies paint or type attributes

Symbol Sprayer (Shift-S) Sprays 
symbol instances into a set

Artboard (Shift-O) Creates and   
document artboards

Hand (H) Moves the document in 
its window

Fill (press X to toggle or click to 
activate) The color, gradient, or 

pattern that fills the inside of a path

Default Fill and Stroke (D) Sets the fill 
color to white and the stroke to black 1 pt. 

Color (<) Resets the fill or 
stroke to the last solid color

Gradient (>) Resets the fill or 
stroke to the last gradient

Type (T) Creates and edits horizontal type 

Gripper bar, for moving the panel

Slice (Shift-K) Defines slice areas of a 
document
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The tearoff toolbars*

Convert Anchor Point 
(Shift-C) Converts corner 
points to smooth points, 
and vice versa

Delete Anchor 
Point (–)

Add Anchor 
Point (+)

Live Paint Selection 
(Shift-L) Selects sections 
of a Live Paint group

Live Paint Bucket (K) Recolors faces 
and edges in a Live Paint group 

Measure Measures the 
distance between two points

Shear Skews objects

Reshape Reshapes 
sections of paths

Rounded 
Rectangle Ellipse (L)

Polygon Flare Creates 
drawings of 
lens flares

Star 

Path Eraser Erases 
sections of paths  

Smooth Smooths path segments

Arc Creates 
curve segments

Spiral Creates 
spiral lines

Rectangular Grid  
Creates rectangular grids

Polar Grid 
Creates  
circular grids

Reflect (O) Creates a mirror 
reflection of an object

Vertical Area Type 
Creates and edits type 
vertically inside an object

Print Tiling  Positions 
the printable page

Slice Selection Selects 
slices, for Web output

Knife Carves up paths

Scissors (C) Splits paths

Symbolism tools (edit symbol instances)

Group Selection Selects whole 
groups (and nested groups)

Crystallize

Wrinkle

Liquify tools (apply distortion)

Twirl

Pucker

Bloat

ScallopWarp (Shift-R) 
Distorts objects

*The tearoff toolbars for the Perspective Grid and Graph tools aren’t illustrated here. 

Symbol 
Styler

Symbol 
Screener

Symbol 
Stainer

Symbol Spinner

Symbol 
Sizer

Symbol 
Scruncher

Symbol 
Shifter

Vertical Type on  
a Path Creates and 
edits type vertically 
along a path

Type on a Path
Creates and edits 
type horizontally 
along a path

Area Type Creates and 
edits type horizontally 
inside an object

Vertical Type 
Creates and 
edits vertical 
type
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The Control panel
The Control panel houses many frequently used 
controls conveniently under one roof, and changes 
contextually depending on what tool and kind of 
object are selected. Two of the many variations are 
shown below. For example, you can use this panel to 
apply fill and stroke colors; change an object’s variable 
width profile, brush stroke definition, or opacity; apply 
basic type attributes, such as the font family and point 
size; align and distribute multiple objects; access 
controls for editing symbols, Image Trace, and Live 
Paint objects; and embed or edit linked images. 

When no objects are selected, you can use this 
panel to choose default fill, stroke, brush, style, and 
opacity settings for the current document and quickly 
access the Document Setup or Preferences dialog by 
clicking the button with that name. 

To move the Control panel to the top or bottom, 
respectively, of the Application frame, choose Dock  
to Top or Dock to Bottom from the menu at the right 
end of the panel. Or if you prefer to make the panel 
free-floating, drag the gripper bar on the far left 
side. To control which options display on the panel, 
uncheck or check any of the items on the panel menu.

➤➤ Options are in more consistent locations on the 
Control panel in Illustrator CS6 than they were  
in version CS5.★

Opening a temporary panel
➤➤ Click a link (word or letter that has a blue 

underline) on the Control panel to open 
a related panel. For example, you could 
click Stroke to open a temporary Stroke 
panel, or click Opacity to open a temporary 
Transparency panel.

➤➤ Click the Stroke or Fill color square on the 
Control panel to open a temporary Swatches 
panel, or Shift-click either square to open a 
temporary Color panel.

➤➤ You can open other temporary panels 
by clicking a thumbnail or arrowhead. For 
example, you could click the Style thumbnail 
or arrowhead to open a temporary Graphic 
Styles panel.

These options are available on the Control 
panel when a whole path, group, compound 
path, or symbol set is selected in a document.

Open a temporary 
Stroke panel

Fill color 
square

Brush 
Definition

Object 
opacity

Variable 
width 
profile

Open a 
temporary 

Transparency 
panel

Graphic 
Styles

Open 
Recolor 
Artwork 

dialog

Stroke 
color 

square Stroke weight

Align to Selection, 
Key Object,  
or Artboard

These options are available on the Control 
panel when an anchor point is selected  
on an object. Clicking the X, Y, W, or H 
opens a temporary Transform panel.

Horizontal and vertical  
location of selected object,  
relative to the ruler origin

Convert 
selected 
anchor 

points to 
corner

Convert 
selected 
anchor 

points to 
smooth

Show handles 
for multiple 

selected 
anchor points

Hide handles 
for multiple 

selected 
anchor points

Remove 
selected 
anchor 
points

Cut path 
at selected 

anchor 
points

Connect 
selected 
endpoints
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Align panel  
The buttons on the top two rows of the Align panel 
align and/or distribute two or more objects along their 
centers or along their top, left, right, or bottom edges. 
Objects can be aligned to a selection, an artboard, or a 
key object (one of the selected objects). Buttons in the 
lower part of the panel redistribute (equalize) the spac-
ing among three or more objects. See pages 105–106. 
This panel can also be used to align anchor points  
(see page 170). Align buttons also appear on the 
Control panel when two or more objects are selected. 

Appearance panel  
The appearance attributes of an object consist of its 
fill and stroke color, Stroke panel settings, effects, 
and Transparency panel settings. The Appearance 
panel lists the specific appearance attributes and 
settings for whichever layer, group, or object is 
currently targeted on the Layers panel. You can use 
the panel to add extra fill or stroke attributes, edit or 
remove attributes, apply and edit effects, and edit 
individual attributes within an applied graphic style. 

Using convenient in-panel features, you can 
edit attributes quickly. For example, you can click 
a link (blue underlined word) to open a dialog or a 
temporary panel: Click Stroke to open the Stroke 
panel, Opacity to open the Transparency panel, or 
the name of an effect to open its dialog. To open a 
temporary Swatches panel, click the Stroke or Fill 
color square, then click the thumbnail or arrowhead 
(or Shift-click the latter to open a temporary Color 
panel). See Chapter 14.

Vertical  
Distribute 

Space

Horizontal Distribute 
Space

Distribute spacing value

Align to Selection, 
Align to Key Object 
(or Key Anchor), or 
Align to Artboard 
options

Horizontal 
Align Left

Vertical 
Align Top

Vertical Distribute Center

Horizontal 
Align Center

Vertical 
Align Center

Horizontal 
Align Right

Vertical Align 
Bottom

Horizontal Distribute Left

Vertical  
Distribute Top

Horizontal  
Distribute Right

Vertical Distribute Bottom

Horizontal Distribute Center

Add New 
Stroke

Add  
New Fill

Add New 
Effect

Clear Appearance

Duplicate 
Selected 

Item

Delete 
Selected 

Item

An effect 
(click to edit)

Link to a 
temporary 

Stroke panel

Visibility  
control for  

an attribute 

The currently targeted entity

showing or hiding panel options
Some of the panels in Illustrator have extra 
options, which you may or may not see at first. 
To display or show a panel’s full options, click 
the double arrow on its tab (once or twice).
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Attributes panel   
The Attributes panel lets you choose overprint 
options for an object (see page 415), show or hide 
an object’s center point (see page 103), switch the 
fill between color and transparency in a compound 
path (see page 348), or change an object’s fill rule. 

You can also use this panel to create a hotspot 
for Web output. Assign an image map shape and a 
URL to a selected object, then to verify the URL in 
the Web browser that is currently installed on your 
system, click the Browser button.

Artboards panel   
In addition to listing all the artboards in the current 
document, the Artboards panel lets you display, 
create, rename, and duplicate artboards; change 
their order; rearrange them in the document; choose 
options for them; change their orientation; and 
delete them. The Artboard Options dialog opens 
when you double-click the artboard orientation icon, 
which is located to the right of the artboard name. 
See pages 7–12 and 28.

Brushes panel     
There are five varieties of decorative brushes that 
you can apply to paths: Calligraphic, Scatter, Art, 
Bristle, and Pattern. You can apply a brush either  
by choosing the Paintbrush tool and a brush and 
then drawing a shape, or by applying a brush to  
an existing path. 

To personalize your brush strokes, you can 
create and edit custom brushes. If you modify a 
brush that’s being used in a document, you’ll be 
given the option via an alert dialog to update 
the paths with the revised brush. Brushes on the 
Brushes panel save with the current document.  
See Chapter 23.

To open a temporary Brushes panel, click the 
Brush Definition thumbnail on the Control panel, 
or for a selected Stroke listing on the Appearance 
panel, click the Brush Definition thumbnail. 

Calligraphic 
brushes

Scatter 
brushes

Plain path  
(no brush) 

Art brushes

Bristle 
brushes 

Pattern 
brushes

Remove 
Brush 
Stroke 

Options of 
Selected 

Object

Brush 
Libraries 

menu

New 
Brush

Delete 
Brush

Don’t Show 
Center and 

Show Center 

Reverse Path 
Direction Off 

and On

Fill Rule options

Delete 
Artboard

New 
Artboard

Move 
Up

Move 
Down

Order of 
artboards

Orientation indicator; access 
to Artboard Options dialogArtboard listings
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Character panel  
You will use the Character panel to apply 
type attributes: font family, font style, 
font size, leading, kerning, tracking, 
horizontal scale, vertical scale, baseline 
shift, character rotation, special glyphs, 
a language to be used for hyphenation, 
and an anti-aliasing method. See pages 
263–266 and 280.

When a type tool or a type object 
is selected, the Control panel also 
provides some basic type controls. To 
open a temporary Character panel, click 
Character on the Control panel.

Font 
Family

Hyphenation language for the current document

Leading 

Horizontal 
Scale 

Kerning

All Caps, Small Caps, 
Superscript, Subscript,★ 

Underline, and Strikethrough 

Tracking

Character 
Rotation 

Anti-
aliasing 
method  

Font Style

Vertical 
Scale 

Font Size

Baseline Shift

Character Styles panel   
A character style is a collection of settings for type 
characters, including a font family, font style, font 
size, leading, tracking, and kerning. Unlike para-
graph styles, which apply to whole paragraphs, 
character styles are used to quickly format small 
amounts of type (such as bullets, boldfaced words, 
italicized words, or large initial caps) to distinguish 
them from the main text. When you edit a character 
style, any text in which it is being used updates 
accordingly. 

Using the Character Styles panel, you can create, 
apply, edit, duplicate, and delete styles. See pages 
274–277. (Compare this panel with the Paragraph 
Styles panel, which is shown on page 51.)

New Style Delete 
Selected 

Styles

Character 
styles

Color panel  
In Illustrator, colors are applied to an object’s fill 
(interior) or stroke (edge). Use the Color panel to 
mix a global process color, enter a hexadecimal 
code, or set a tint percentage for a spot color. 
Choose a color model for the panel, such as RGB 
or CMYK, from the panel menu. Quick-select 
a color by clicking in the spectrum bar at the 
bottom of the panel, or click the black, white, or 
None button. You can expand the bar by dragging 
the gripper bar downward.★ See page 117.

To open a temporary Color panel, Shift-click  
the Fill or Stroke square or arrowhead on the 
Control panel or the Appearance panel. 

Expandable color 
spectrum bar ★

Hex value ★

Fill 
square

Stroke 
square

Out of Web Color 
alert and In Web 
Color substitute

Out of Gamut  
alert and In 

Gamut Color 
(printable) 
substitute
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Color Guide panel    
Use the Color Guide panel to generate color 
schemes from a base color by choosing a harmony 
rule and/or a variation type (Tints/Shades, Warm/
Cool, or Vivid/Muted). You can click any variation 
swatch to apply it as a fill or stroke color to one 
or more selected objects. You can also save varia-
tions from the Color Guide panel as a group to the 
Swatches panel, or edit the current color group via 
the Edit Colors dialog. See pages 115 and 128–130.

Flattener Preview panel   
Artwork that contains semitransparent objects must 
be flattened before it is printed. Using the Highlight 
menu options in the Flattener Preview panel, you 
can preview which objects in your document will be 
affected by flattening, adjust the flattening settings, 
then click Refresh to preview the effect of the new 
settings in your artwork. See page 418.

Limit Color Group to Colors 
in Swatch Library menu

Save Color Group 
to Swatch panel

Edit Colors

Base Color 
and active 

color group

Set Base Color 
to Current Color

Harmony Rules menu 

Document Info panel   
The Document Info panel lists data about artwork 
in your document, depending on which category is 
chosen on the panel menu: Document (all data), or all 
Objects, Graphic Styles, Brushes, Spot Color Objects, 
Pattern Objects, Gradient Objects, Fonts, Linked 
Images, Embedded Images, or Font Details. If Selection 
Only is chosen on the menu, the panel lists data 
pertaining to just selected object(s). See page 432.
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Glyphs panel  
Using the Glyphs panel, you can find out which 
character variations (alternate glyphs) are available 
for any given character in a specific OpenType font, 
and insert specific glyphs from that font into your 
document (including glyphs that can’t be entered 
via the keyboard). See page 269.

Font family Pop-up showing alternate 
glyphs for a specific character

Font style Zoom Out Zoom In

Show menu for controlling 
whether the panel displays 
glyphs in a specific category 
or for the entire font

Unicode for the currently 
selected character

Gradient panel   
The Gradient panel lets you create, apply, and edit 
gradients, which are soft, gradual blends between 
two or more colors. You can use the panel to apply 
a gradient to an object’s fill or stroke,★ adjust the 
amount of a color by dragging its stop, choose a 
different color or opacity value for a selected stop, 
click below the gradient slider to add new colors, 
move a midpoint diamond to change the location 
where two adjacent colors are mixed equally, reverse 
the gradient colors, change the overall gradient type 
or angle, or change the alignment of a gradient in an 
object’s stroke. See Chapter 24.

Gradient square

Gradient menu

A gradient 
color stop

Reverse Gradient 
colors

Fill and Stroke 
squares ★

Gradient type: Radial or Linear

A midpoint 
diamond

Opacity of color stop

Aspect ratio

Options for 
aligning the 
gradient in 
the stroke ★

Delete stop

Location of color stop 
or midpoint diamond

Indicator that the 
opacity of the stop is 

below 100%

Angle
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Graphic Styles panel   
The Graphic Styles panel enables you to store and 
apply collections of appearance attributes, such as 
multiple solid-color fills or strokes, transparency and 
overprint settings, blending modes, brush strokes, and 
effects. Using graphic styles, you can apply attributes 
quickly and create a cohesive look among multiple 
objects or documents (similar to how paragraph styles 
are used with type). See Chapter 16. To open a tempo-
rary Graphic Styles panel, click the Style thumbnail or 
arrowhead on the Control panel.

Image Trace panel    ★
The Image Trace feature detects and traces areas 
of color and shade in a raster image that is opened 
or placed into Illustrator, such as a Photoshop, TIFF, 
or JPEG image or scanned artwork, and converts 
those areas to Illustrator paths. 

You can choose from a wide array of tracing 
options on the Image Trace panel prior to the 
tracing — and because a tracing is “live,” you can 
also use the panel to fine-tune the results. You  
can use a built-in tracing preset (predefined 
settings) as a starting point, or create and apply 
custom presets. Among the numerous settings 
that you can specify are a mode (black and white, 
grayscale, or color), a color palette, the number of 
resulting colors, whether fill and/or stroke colors 
are produced, and the precision with which the 
image is traced. See Chapter 17.

Graphic Styles 
Libraries menu

Delete 
Graphic Style

New Graphic 
Style

Break Link to 
Graphic Style

Tracing 
presets

Preview 
options

Color mode

Color 
palette

Adjust the 
color accuracy

Control the 
number of paths, 

corners, and small 
extraneous paths

Control whether the 
resulting objects abut 

or overlap one another

Choose whether the 
tracing contains  

fills and/or strokes 

Readouts of the 
current tracing 

components
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Info panel  
If no objects are selected in the current document,  
depending on the current tool, the Info panel 
lists the x,y (horizontal and vertical) location of 
the pointer. If an object is selected, the panel lists 
the location of the object, its width and height, 
and data about its fill and stroke colors (the color 
components; or the name of a pattern or gradient; 
or a color name or number, such as a PANTONE 
PLUS number). While an object is being trans-
formed via a transform tool, the panel lists perti-
nent information, such as a percentage value for a 
scale transformation or an angle of rotation. When 
a type tool and type object are selected, the panel 
displays type specifications. When the Measure tool 
is used, the Info panel opens automatically and lists 
the distance and angle the tool has just calculated.

Layers panel    
The indispensable Layers panel lets you add and 
delete layers and sublayers in a document, and 
create layer groups. You can also use this panel to 
select, target, restack, duplicate, delete, hide, show, 
lock, unlock, merge, change the view for, or create 
a clipping set for a layer, sublayer, group, or individ-
ual object. When your artwork is finished, you can 
use a command on the panel menu to flatten the 
document into one layer or release all the objects 
to separate layers for export as a Flash animation. 
See Chapter 13. 

Location  
of selected 

object

Stroke info

Fill info

Width and height of the currently selected object

Links panel     
When you place an image from another application, 
such as Photoshop, into an Illustrator document, 
you can opt to have Illustrator embed a copy of the 
image into the file (and thereby increase the file size 
but allow the program to color-manage it) or merely 
link the image to your document (and minimize the 
file size but require the original file to be available for 
print output). Using the Links panel, you can monitor 
the status of linked images, convert a linked image to 
an embedded one, open a linked image in its origi-
nal application for editing, update an edited image, 
and restore the link to an image that is missing or 
modified. See pages 300–303.

Visibility 
icon (hides 

or shows 
the entity)

Selection 
square

New 
Sublayer

New 
Layer

Delete 
Selection

Lock icon 
(makes 

the entity 
uneditable)

Make/Release 
Clipping Mask

Locate 
Object ★

Icon for targeting an 
object or group (to edit  
its appearance attributes)

Current 
Layer 

indicator

Relink Go to 
Link

Update 
Link

Edit 
Original

Modified Linked 
Image indicator

Missing Image 
indicator
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Magic Wand panel  
The Magic Wand tool selects objects that have the 
same or a similar fill color, stroke color, stroke weight, 
opacity, or blending mode as the currently selected 
object. Using the Magic Wand panel, you specify which 
attributes the tool may select and set a tolerance value 
for each attribute. For example, if you were to check 
Opacity, choose an opacity Tolerance of 10%, then click 
an object that has an opacity of 50%, the tool would 
find and select objects in the document that have an 
opacity between 40% and 60%. See page 97. 

Navigator panel    
The Navigator panel has two main functions. To use 
it to move the current document in its window, drag 
or click in the proxy preview area (red outlined box). 
To change the document zoom level, use the zoom 
controls at the bottom of the panel. To both zoom 
to and bring a specific area of a document into view, 
Cmd-drag/Ctrl-drag in the proxy preview area.

OpenType panel  
Among the Roman OpenType font families that ship 
with Illustrator, the fonts that contain an expanded 
character set and a large assortment of alternate 
glyphs are labeled with the word “Pro.” By clicking a 
button on the OpenType panel, you can specify which 
alternate characters (glyphs) will appear in your text 
when you type the requisite key or keys. The special 
characters for a given font may include ligatures, 
swashes, titling characters, stylistic alternates, ordinals, 
and fractions. You can also use the panel to specify 
options for numerals, such as a style (e.g., tabular lining 
or oldstyle) and a position (e.g., numerator, denomina-
tor, superscript, or subscript). See page 270.

opening the panels for editing type
Illustrator provides seven panels for edit-
ing type: Character, Character Styles, Glyphs, 
OpenType, Paragraph, Paragraph Styles, and 
Tabs. All of them can be opened via the 
Window > Type submenu; the Glyphs panel 
can also be opened via the Type menu. Four 
of them can also be opened via a shortcut, as 
listed below.

	 Mac OS	 Windows        

Character Cmd-T Ctrl-T

OpenType Cmd-Option-
Shift-T

Ctrl-Alt-Shift-T

Paragraph Cmd-Option-T Ctrl-Alt-T

Tabs Cmd-Shift-T Ctrl-Shift-T

Standard 
Ligatures

Contextual 
Alternates

Discretionary 
Ligatures

Stylistic 
Alternates

Titling 
Alternates

Ordinals

FractionsSwash

Style and 
position 
options 

for 
numerals

Proxy 
preview 

area

Zoom Level 
field 

Zoom Out Zoom slider Zoom In
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Paragraph panel  
Use the Paragraph panel to apply settings that affect 
entire paragraphs, such as horizontal alignment, inden-
tation, spacing before or after, and automatic hyphen-
ation. Via the panel menu, you can choose hanging 
punctuation and composer options and open a dialog 
for choosing justification or hyphenation options. See 
pages 267, 271–273, and 278. 

The Align Left, Align Center, and Align Right buttons 
are also available on the Control panel when a type 
object is selected. To open a temporary Paragraph 
panel, click Paragraph on the Control panel.

Paragraph Styles panel  
A paragraph style is a collection of paragraph specifi-
cations (including horizontal alignment, indentation, 
spacing before or after, word spacing, letter spacing, 
hyphenation, and hanging punctuation), as well as char-
acter attributes, such as the font family, font style, and 
font size. When you apply a paragraph style to one or 
more selected paragraphs, the type is reformatted with 
the specifications in that style. When you edit a para-
graph style, the type in which it is being used updates 
accordingly. With paragraph (and character) styles, you 
can typeset text quickly and ensure that the formatting 
is consistent. Use the Paragraph Styles panel to create, 
store, apply, edit, duplicate, and delete paragraph styles 
for the current document. See pages 274–277.
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Pathfinder panel  
Depending on how they are applied, the Shape 
Mode commands on the top row of the Pathfinder 
panel combine selected, overlapping objects into one 
or more standard paths or into a compound shape. The 
Expand button converts a compound shape into either 
a path or a compound path (the latter if the command 
originally produced a cutout shape). The Pathfinder 
buttons on the bottom row of the panel produce flat-
tened, cut-up shapes from multiple selected objects. 
See pages 341–346.
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Separations Preview panel    
The Separations Preview panel gives you an idea of 
how the individual C, M, Y, and K color components 
in a CMYK document will separate to individual 
plates during the commercial printing process. You 
can use the panel to check that a color is properly set 
to knock out colors beneath it in your artwork, or to 
check whether a color is properly set to overprint on 
top of the other colors. Other uses for the panel are 
to monitor the use of spot colors in the artwork, to 
verify that any spot color is set to knock out colors 
beneath it, and to determine whether a specific black 
is a rich black (a mixture of C, M, Y, and K inks) or a 
simple black that contains only the K component. 
See pages 414–415.

Hide or show a separation ink

Pattern Options panel    ★
Via the Pattern Options panel, along with some 
intuitive on-image controls, you can create 
and edit seamless patterns. When you create a 
pattern, it appears automatically on the Swatches 
panel for the current document. You can apply 
any pattern swatch in the Swatches panel to an 
object’s fill (interior) or stroke (edge). 

The Pattern Options panel lets you change 
the pattern tiling configuration (Grid, Brick, or 
Hex); adjust the spacing between tiles; and for 
objects that straddle the tile boundary and 
overlap one another, control which objects are 
in front. You can also choose preview options 
for pattern-editing mode, including the number 
of copies that display, to what extent the copies 
are dimmed, and whether the tile and/or swatch 
boundaries display. See pages 135–142.
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Stroke panel  
Stroke settings control the appearance of an 
object’s path (edge). By using the Stroke panel, 
you can specify a stroke weight (thickness), 
cap (end) style, and corner (join) style, and an 
alignment option to control the position of the 
stroke on the path. You can also use the panel to 
create a dashed (or dotted) line or border, apply 
an arrowhead and/or tail style, and change the 
stroke width profile. See pages 120–122 and 162. 
To open a temporary Stroke panel, click Stroke 
on the Control or Appearance panel. 

Swatches panel  
Use the Swatches panel to choose, store, and apply 
solid colors, patterns, gradients, and color groups. 
If you click a swatch, it becomes the current fill 
or stroke color (depending on whether the Fill 
or Stroke square is active on the Tools panel and 
Color panel), and it is applied to all currently 
selected objects.

Double-clicking a swatch opens the Swatch 
Options dialog, in which you can change the 
swatch name or change its type to global process, 
nonglobal process, or spot. See pages 114, 116, 
118, 124–127, and 132. To open a temporary 
Swatches panel, click the Fill or Stroke square or 
arrowhead on the Control or Appearance panel. 

Symbols panel   
Symbols are Illustrator objects that are stored on 
the Symbols panel and save with the current docu-
ment. Using symbols, you can quickly and easily 
create a complex collection of objects, such as a 
bank of trees or clouds. To create one instance of a 
symbol, you simply drag from the Symbols panel 
onto the artboard; to assemble multiple instances 
quickly into what is called a symbol set, you use the 
Symbol Sprayer tool. 

The other symbolism tools let you change the 
position, stacking order, proximity, size, rotation 
angle, or transparency of multiple instances in a set, 
or gradually apply a color tint or graphic style —  
while maintaining the link to the original symbol 
on the panel. If you edit the original symbol, all 
instances of that symbol in the document update 
automatically. See Chapter 28.
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Tabs panel   
The only way to align columns of text precisely is 
by using tabs and the Tabs panel. Using the panel, 
you can insert, move, and change the alignment 
of custom tab markers, specify a leader (such as 
a period character, to produce a dotted line), and 
specify a character for your text to align to (such 
as a decimal point). See pages 278–279.

Transform panel   

The Transform panel lists the location, width, height, 
rotation angle, and shear angle of the currently 
selected object, and can be used to change those 
values. By clicking a reference point, you can control 
what part of the object the transformations are 
calculated from. The panel can also be used to align 
selected objects to the pixel grid. Via commands on 
the panel menu, you can control whether just the 
object, the object and a fill pattern, or just the fill 
pattern is transformed. See pages 148–149. 

A reference point icon and X, Y, W, and H fields 
also appear on the Control panel when one or more 
paths are selected. To open a temporary Transform 
panel, click the X, Y, W, or H link (or if those fields 
aren’t showing, click the word “Transform”). 

Transparency panel   
You can use the Transparency panel to change 
the blending mode or opacity of a layer, group, or 
individual object. The Make Mask button applies 
the opacity value and grayscale equivalent of 
a color (or colors), gradient, or pattern in the 
topmost object to underlying selected objects, 
and optionally hides sections of those objects that 
extend beyond its edges. See Chapter 27.

To open a temporary Transparency panel, click 
the Opacity link on the Control or Appearance 
panel. You can also change the opacity of an object 
directly via the Control panel.
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